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ABSTRAKT, KLÍ ČOVÁ SLOVA 

ABSTRAKT  

Cílem této diplomové práce je provést citlivostní studii vlivu polohy karoserie vozu 
na jeho aerodynamická zatížení. Byl vytvořen model CAD model v softwaru Pro/Engineer, 
předlohou byly rozměry podvozku a karoserie formule Ford 1600. Následně byl model 
převeden do prostředí CFD, zde byly nastaveny charakteristiky struktury okolního média. 
Software FLUENT provedl výpočty a měření aerodynamických charakteristik vozidla 
v závislosti na nastavení výšky a natočení podvozku vozidla. 

 

KLÍČOVÁ SLOVA  
aerodynamické charakteristiky, formule Ford 1600, karoserie vozu, výška a natočení 
podvozku 

ABSTRACT  

Aim of this diploma thesis is to make sensitivity research concerning influence of vehicle 
body position on its aerodynamical loading. CAD model was created in Pro/E software. 
Formula Ford 1600 chassis and vehicle body dimensions were used as a pattern for CAD 
model. Then this model was imported into CFD environment where ambient medium 
characteristic were set up. FLUENT software performed calculations and measurement of 
aerodynamical characteristics of vehicle dependent on height and angle of chassis. 

 

KEYWORDS 
aerodynamical characteristics, formula Ford 1600, vehicle body, height and angle of chassis  
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ÚVOD 

ÚVOD 
Jakmile spatřily světlo světa první automobily, ihned se našli jedinci, kteří s nimi 

chtěli závodit a zjistit, kdo disponuje nejlepším vozidlem. Od roku 1894, kdy se ve 
Francii  konal první automobilový závod, uběhlo více než 117 let. Soutěživost a rivalita mezi 
soupeři vedly k vynalezení mnoha technických postupů a řešení výroby automobilů a také 
k jejich postupnému zdokonalování. Konstruktéři těchto vozů brzy zjistili, že vhodně zvolený 
tvar karoserie bude mít klíčový vliv na jízdní vlastnosti jejich vozů. A proto jdou pojmy 
design a aerodynamika ruku v ruce s automobilovým průmyslem téměř od jeho vzniku. 

Dnes je na aerodynamiku vozu kladen velký důraz. V automobilním průmyslu má za úkol co 
nejvíce zefektivnit provoz vozidla. To je dosaženo snižováním aerodynamického odporu, což 
má za následek lepší využití výkonu motoru, menší měrnou spotřebu paliva a snížení emisí. 
V závodním odvětví aerodynamika využívána především ke zlepšení jízdních vlastností, 
zvětšení přítlaku vozidla na vozovce, aby mohlo být dosahováno větších výkonů a rychlostí.    

Tato diplomová práce se zabývá měřením aerodynamických charakteristik modelu formule 
Ford 1600 v aerodynamickém tunelu, který byl vytvořen ve výpočtovém prostředí CFD 
(Computational Fluid Dynamics). Požadavkem bylo, aby byl podvozek na CAD modelu 
formule parametrický, tzn., aby bylo možné nastavovat výšku a úhel natočení karoserie 
vzhledem k vozovce. Úkolem je zanalyzovat a zhodnotit výsledné aerodynamické 
charakteristiky vozidla pro čtyři různá nastavení podvozku. 
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Obr. 1 Vznik smykového napětí mezi 
dvěma deskami s viskózní tekutinou  

1 TEORIE AERODYNAMIKY VOZIDEL  
Aerodynamika je obecně vědním oborem, který se zabývá silovým působením na 

těleso, které je obtékáno proudem vzduchu. Tudíž klíčový význam plní aerodynamika 
v leteckém, automobilním a stavebním průmyslu. 

Proudění vzduchu je relativní. Na tělese obtékaném proudem vzduchu dojde ke změně 
rychlosti vzduchu a v důsledku toho i ke změně tlaku na jednotlivých plochách tělesa. Po 
sečtení účinku působení dílčích tlaků dostaneme výslednou hodnotu aerodynamické síly 
působící na těleso.  
 
Statický tlak – tlak vyvozený tekutinou za relativního klidu, měříme u stěny, kde je nulová 
rychlost 

Dynamický tlak  - tlak, kterým působí proudící kapalina na statické těleso nebo tlak pohy-
bujícího se tělesa na klidnou kapalinu  

Celkový tlak – součet statického a dynamického tlaku 

 

1.1 VLASTNOSTI TEKUTIN  
Pro uplatnění základních principů aerodynamiky musíme pochopit vlastnosti tekutin. 

Síla potřebná k pohybu vozidla skrze vzduch závisí na fyzikálních vlastnostech okolní 
tekutiny, zejména na teplotě, tlaku, viskozitě a hustotě. Základním rozdílem mezi tekutinou a 
tuhým tělesem pohyblivost molekul, mezi kterými neexistují tak pevné vazby. Tato vlastnost 
se označuje jako tekutost. Kapaliny a plyny tečou v proudu omezeném stěnami, oproti tuhému 
tělesu, které se pohybuje jako jeden celek hmotných bodů. Obě tekutá skupenství, plynné i 
kapalné, se od sebe navzájem dost liší. Zásadní rozdíl je v objemové stálosti. Plyny jsou 
oproti kapalinám snadno stlačitelné, nemají stálý tvar ani objem, netvoří hladinu. 

Viskozita – je definována jako odpor vrstev tekutiny vůči pohybu. Příčinou je vznik 
smykového napětí mezi dvěma okolními vrstvami. Na obrázku 1 jsou znázorněny dvě 
rovnoběžné desky a mezi nimi viskózní tekutina. Spodní deska je v klidové poloze. Při 
pohybu vrchní desky nám vzniká smykové napětí, viz obr. 1. Hustší tekutiny mají větší 
viskozitu, protože jejich pohyb je znesnadněn meziatomovými silami, viskozita nám 
způsobuje vznik mezní vrstvy. V mezní vrstvě je rychlost pohybu molekul tekutiny nulová. 

Při teplotě 20°C a tlaku 101 kPa je hustota vzduchu 1,22 kg/m3a viskozita 1,8・10-5Ns/m2. 
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1.2 BERNOULLIHO ROVNICE 
Při aplikaci této základní rovnice mechaniky tekutin na obtékání automobilu vyplývá, že 
součet statického a dynamického tlaku v každém bodě povrchu karosérie je konstantní a je 
rovný součtu statického a dynamického tlaku v nerušeném proudu vzduchu. Členitost 
karoserie způsobuje změnu směru a rychlosti obtékaného proudu a vzniká nám 
aerodynamické zatížení. Tyto vztahy mezi rychlostí proudění a tlakem nám pro ustálené 
proudění beze ztrát popisuje Bernouliho rovnice ve tvaru: 

�� + ��
2 = �	
��, (1)  

Bernoulliho rovnice (2) slouží k porovnání rychlostí a tlaků ve dvou libovolných různých 
bodech pro spojité proudění s konstantní hustotou proudící tekutiny. 

��� + ���2 = ��� + ���2  (2)  

Bernoulliho rovnice (3) složí k popsání celkového tlaku. 

12 ��� + � + ��ℎ = �����,����� (3)  

kde  
�� ���  je dynamický tlak způsobený rychlostí prodění, p je statický tlak a ��ℎ  je 

hydrostatický tlak. 

 

1.3 TYPY PROUDĚNÍ KAPALIN  
Proudění vzniká, uvažujeme-li pohyb tekutiny v jednom směru. V proudící tekutině má každá 
částice svou vektorovou rychlost, která se může místně měnit v závislosti na čase. 

Proudnice je trajektorií pohybu jednotlivých částic tekutiny, každý bod má jednu proudnici, 
které se navzájem neprotínají. Rychlost částice v libovolném místě proudu je tečnou 
k proudnici. 

 

1.3.1 STACIONÁRNÍ (USTÁLENÉ) A NESTACIONÁRNÍ (NEUSTÁLENÉ) PROUDĚNÍ 

Stacionární proudění je takové proudění, při němž jsou tlak p a rychlost v v proudící 
tekutině stálé veličiny, tzn., nejsou závislé na čase.   

Oproti tomu u nestacionárního proudění jsou tlak p a rychlost v v proudící tekutině závislé na 
čase. 

1.3.2 LAMINÁRNÍ A TURBULENTNÍ PROUD ĚNÍ 

Pro laminární proudění je charakteristický rovnoběžný posun jednotlivých vrstev. 
Proudnice jsou spojité křivky, které se navzájem nekříží, viz obr. 2a. 
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U turbulentního proudění se rychlost v daném bodě nepravidelně mění, proudnice se vlivem 
prostředí roztáčejí a následně kříží, vznikají nám turbulence = víry, viz obr. 2b. 

 

 Přechod mezi laminárním a turbulentním prouděním je dán Reynoldsovým číslem 

�� = �.  !  (4)  

kde V je rychlost proudění, d je charakteristický rozměr a ν je kinematická viskozita. 

 

1.3.3 PŘILNUTÉ A ODTRŽENÉ PROUDĚNÍ 

Trajektorie proudu, která při průchodu kolem karoserie vozu opisuje její tvar, 
nazýváme přilnuté proudění, viz obr. 3a. S tímto typem proudění se u automobilů spíše 
nesetkáváme, jde pouze o ideální stav, cílem je se k němu co nejvíce přiblížit. Vzniká při 
obtékání kapkovitého profilu. Odtržené proudění nalezneme v zadní části vozu, kde se 
odtrhává mezní vrstva. Odtržené proudění má velký vliv na aerodynamické charakteristiky 
vozidla, viz obr. 3b. 

 

Obr. 2 Průběh laminárního a turbulentního proudění  

Obr. 3 Přilnuté a odtržené proudění [11] 
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1.4 MEZNÍ VRSTVA 
V těsné blízkosti povrchu těles jsou třecí síly stejně velké jako dynamické. Proto při 

obtékání tělesa dochází k ulpívání částic kapaliny na povrchu obtékaného tělesa. Na povrchu 
je rychlost částic nulová a se zvětšující se vzdáleností od povrchu rychlost parabolicky roste. 
Velikost mezní vrstvy na povrchu vozidla je v různých místech rozdílná, v přední části 
v řádech milimetrů, v zadní části v řádech centimetrů. 

 

 

1.4.1 LAMINÁRNÍ A TURBULENTNÍ MEZNÍ VRSTVA  

Tvar a velikost mezní vrstvy závisí na profilu obtékaného tělesa. Stanovení přesných 
charakteristik je složité i pro jednoduché profily typu rovinná deska. Početní řešení u 
komplikovanějších tvarů je velmi složité, někdy i neřešitelné. 

      

Na obrázku 5 je znázorněna změna tloušťky laminární mezní vrstvy δL při obtékání 
nekonečně tenké desky proudem tekutiny o rychlosti V∞, jejíž směr obtékání je rovnoběžný 
s touto deskou. Za předpokladu, že se na desce tvoří laminární proudění, platí pro délku xL 
vztah: 

Obr. 5 Laminární a turbulentní mezní vrstva [11] 

Obr. 4 Mezní vrstva na povrchu automobilu [3] 
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"# = 5. %&. '#()  (5)  

Častěji se však setkáváme s kombinací laminární a turbulentní mezní vrstvy. Od 
náběžné hrany se tvoří laminární vrstva. V určité vzdálenosti, zobrazené bodem A, dojde ke 
zvratu a k tvoření turbulentní mezní vrstvy, která se začne šířit směrem k rovinné desce i do 
volného prostoru. Pod ní však stále zůstává v určité míře laminární mezní vrstva. Ke zvratu 
dochází v místě, kde Reynoldsovo číslo (4) dosáhne určité hodnoty, které je závislé na tvaru 
tělesa. 

Re < 2.105 …  laminární mezní vrstva, dochází k odtržení a k úplavu 

Re ≥ 2.105 …  přeměna laminární vrstvy na turbulentní, vzniklý úplav je malý, což má za 
  následek menší součinitel odporu vzduchu  

 

1.4.2 ODTRŽENÍ MEZNÍ VRSTVY 

Při obtékání tělesa se kinetická energie proudící kapaliny mění na tlakovou energii. Na 
povrchu v bodě S se proud zastaví (v = 0) a v bodě M dochází dokonce ke zpětnému proudění. 
Od bodu S se mezní vrstva odděluje od tělesa a vzniká úplav. Odtržení nastává vzrůstem tlaku 
v mezní vrstvě, částice s nízkou kinetickou energií se zastaví a později odtrhnou, viz obr. 6. 

 

V každém úplavu je neuspořádané proudění, což nám zapříčiňuje vzrůst energetických 
ztrát, zvýšenou dynamiku zařízení a hluk. Toto je z aerodynamického hlediska nežádoucí, 
proto se snažíme tento jev odstranit nebo alespoň minimalizovat.   

 

 

 

Obr. 6  Rychlostní profily při obtékání válce a vznik úplavu 
[11]  
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1.5 OBTÉKÁNÍ KOL  
Při zjišťování aerodynamiky vozidla je důležitým prvkem obtékání kol. Jedná-li se o 

automobil s nekrytými koly, vliv rotujících kol se projeví o to více. Dříve bylo měření v aero-
dynamickém tunelu omezeno jen na model se stacionárními koly, v současné době moderní 
aerodynamické tunely umožňují simulovat modely i s rotujícími koly, viz kapitola 2.1. 

Obtékání kol se nejvíce blíží obtékání válce. Na obrázku 7 je ukázán rozdíl v proudění 
kolem válce ve volném prostoru a v přítomnosti vozovky. 

 

Rozdílné je i obtékání stacionárního a rotujícího kola. Rozhodujícím parametrem 
ovlivňujícím koeficient vztlaku a odporu je místo odtržení přilnutého proudění. U 
stacionárního kola dochází k odtržení proudu vzduchu v úhlu θ ≈ 160º, u rotujícího kola je 
úhel větší, protože se proud odtrhává dříve. 

  

 

Rozložení tlaku na obtékaném kole je charakterizováno koeficientem tlaku cD. Kladná 
hodnota v přední části kola a záporná v zadní části kola nám způsobuje aerodynamický odpor. 
Na obrázku 8 je zobrazení tlakových polí na kole. U stacionárního kola můžeme pozorovat 
zápornou hodnotu, vzniká nám vztlak. U rotujícího kola je tato hodnota menší, někdy 
dokonce kladná, což nám způsobí přítlak. Tento případ označujeme jako Magnusův jev. 

Obr. 7 Obtékání válce ve volném prostoru a v blízkosti rovinné 
desky [3] 

Obr. 7 Obtékání stacionárního a rotujícího kola [3] 
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1.5.1 MAGNUSŮV JEV 

Označujeme jím vznik boční (v případě horizontálního umístění osy válce vztlako-
vé) síly při obtékání rotujícího tělesa proudícím plynem nebo kapalinou. Poprvé tento jev 
podrobněji popsal Gustav Heinrich Magnus v roce 1852. První zmínka o tomto jevu pochází 
už z roku 1672 od Isaaca Newtona. Jev je významný zvláště ve vnější balistice. Jev se 
projevuje u mnoha sportů, kde ovlivňuje dráhu míče (kopaná, tenis, golf atd.), hraní pomocí 
kulečníku pomocí falší. Například golfový míček má pro zesílení jevu na povrchu množství 
prohlubní. 

 
 

 
Aplikací Magnusova jevu je například Flettnerův rotor. Jedná se o rotor, který byl 

použit na lodích, jeho funkce byla obdobná jako plachta. Ve dvacátých letech 20. Století se 
tento princip aplikoval na pohon lodi vynálezce Anton Flettner. S pokusnou lodí, využívající 
pohon dvou 18 metrů vysokých válců, překonal v roce 1926 Atlantský oceán. 
S rozporuplnými výsledky byl Magnusův jev uplatněn i pro nahrazení konstrukce křídla 
rotujícím válcem. 

Obr. 8 Vznik boční (vztlakové) síly u Magnusova jevu [12] 

Obr. 8 Rozložení tlaku na stacionárním a rotujícím kole [3] 
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1.6  SOUSTAVA AERODYNAMICKÝCH SIL A MOMENT Ů, AERODYNAMICKÉ  

 KOEFICIENTY 

 

Celková aerodynamická síla má obecný směr a velikost. Proto ji rozkládáme do os 
souřadnicového systému se středem v bodě 0. Bod 0 se nachází na průsečíku roviny symetrie 
vozidla, roviny nacházející se v polovině rozvoru kol a rovinou vozovky. Velikosti 
aerodynamických sil vzhledem k těžišti je nutno dopočítat. 

Celkové aerodynamické účinky na vozidlo můžeme rozložit do šesti složek, třech silových a 
třech momentových.  

 

 

Obr. 9 Ukázky aplikací Magnusova jevu [13] 

Obr. 10 Soustava aerodynamických sil a momentů 
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*+ = − �� . �+. �. �)�. -  … Aerodynamický vztlak (7)  

*. = − �� . �. . �. �)�. -   …  Aerodynamická boční síla (8)  

V je rychlost relativního proudění, c je koeficient aerodynamického odporu, ρ je hustota a A je 
průmět čelní plochy na rovinu za vozidlem. 

 

r je rozchod kol, l je rozvor kol. 

 

*/ = − �� . �/. �. �)�. -  … Aerodynamický odpor (6)  

0/ = �� . �1/. �. �)�. -. 2  … Moment klopení (9)  

0+ = �� . �1+. �. �)�. -. 4  … Moment klonění (10)  

0. = �� . �1.. �. �)�. -. 4  … Moment stáčení (11)  

�5 = �/ = 6789.:.;<9 .�     … Koeficient odporu vzduchu (12)  

�# = �. = 6=89.:.;<9 .�     … Koeficient tlaku (13)  
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2 ZJIŠŤOVÁNÍ AERODYNAMICKÝCH CHARAKTERISTIK U 
VOZIDEL

Stanovení optimální aerodynamiky je jedno z hlavních hledisek při konstruování vozu. 
V automobilním průmyslu je snižování odporového součinitele cx velmi ostře sledovaným 
kritériem, které dopomáhá k hospodárnějšímu provozu vozidel, nižší měrné spotřebě, nižší 
produkci škodlivin ve výfukových plynech a může významně ovlivnit i prodejnost 
automobilu.  

V závodním průmyslu jsou dávno pryč doby, kdy bylo zvýšení výkonu a zlepšení jízdních 
charakteristik řešeno pouze výměnou pohonné jednotky za větší a výkonnější motor. Dnes 
patří aerodynamika jízdních speciálů ke chráněnému tajemství jednotlivých týmů. 

Stanovení součinitelů aerodynamických odporů se zjišťuje následujícími způsoby: 

• Měřením zmenšeného modelu v aerodynamickém tunelu 
• Měřením skutečného modelu v aerodynamickém tunelu  
• Pomocí numerických výpočtů 

 
2.1 AERODYNAMICKÝ TUNEL  

Pro testování aerodynamiky automobilů se používají nízkorychlostní tunely. Průměr 
měřícího prostoru, kde je umístěn model, se pohybuje kolem pěti metrů, rychlost proudění 
dosahuje až 100 km/h, příkon ventilátoru je 2,5 MW. Používá se konstrukce s otevřeným 
nebo uzavřeným okruhem.  

 

 

 

Vzduch, který obíhá uvnitř tunelu, musí mít specifické vlastnosti, jako je teplota, 
vlhkost apod. Prochází celou řadou procesů, které mají za úkol proud vzduchu uklidnit, aby 
byl jeho tok plynulý a stejnoměrný, což je hlavním předpokladem pro přesnost a 
opakovatelnost výsledků. Vzduch je nejprve zpomalen vtokem do široké části tunelu, poté je 
zchlazen a odveden do zklidňující komory. Zde prochází mezi lamelami, které usměrní tok 

Obr. 12 Konstrukční provedení tunelů [1]  
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vzduchu. Ten se napřímí a síťové přepážky odstraní zbylé turbulence. Ze zklidňující komory 
pokračuje vzduch do zužující se části, kde se zvýší rychlost na potřebnou hodnotu a vstupuje 
do testovacího prostoru. 

Automobil je v aerodynamickém tunelu speciální případ, je nutno zajistit požadované 
proudění mezi vozidlem a vozovkou. U měření vozidel se stacionárními koly docházelo 
k určité chybě při výpočtu. Dnes již u moderních aerodynamických tunelů existují zařízení 
pro simulaci jízdy modelu po vozovce. Ke skutečnosti se nejvíce přibližuje koncepce 
zobrazená na obrázku 12 c), kde je pohyb kol zajištěn pásovým dopravníkem, který jízdu po 
vozovce simuluje nejlépe. Model je na pásu upevněn vzpěrami, konstrukce dopravníku je 
ošetřena proti vzniku statické elektřiny od pohybujících se kol. Na podobném principu 
funguje i model umístěný na válcích, konstrukce je obdobná jako při měření na výkonových 
charakteristik na brzdě. Zde se dají měřit zátěžové charakteristiky pomocí speciálních 
snímačů pod každým kolem, dá se simulovat i průjezd zatáčkou. Dalšími možnostmi je 
odsávání vzduchu pod autem d) nebo tangenciální foukání vzduchu pod vůz b). 

 

 

 

Dříve se pro vizualizaci průběhu proudění používala bavlněná vlákna nebo proužky 
papíru, dnes existují kouřové sondy, jejichž vstřikované médium se vlastnostmi hodně blíží 
proudícímu vzduchu kolem karoserie. 

 

2.2 VÝPOČTOVÉ PROGRAMY 
V dnešním světě je díky rychlému nárůstu výkonu výpočtových stanic možno 

simulovat proudění na počítači s příslušným softwarem. Nyní je nejhojněji používaná 
výpočtová dynamika tekutin CFD (Computational Fluid Dynamics), která umožňuje 
konstruktérům simulovat a analyzovat aerodynamické vlastnosti jednotlivých dílů ještě před 
tím, než jsou vyrobeny. Zjednodušeně si CFD můžete představit jako aerodynamický tunel 
v počítači. Tento postup nám šetří čas potřebný na výzkum a vývoj, nahrazuje finančně 
náročnější simulaci skutečného modelu v aerodynamickém modelu a virtuální simulace je 

Obr. 12 Odtržení proudění od stacionárního a rotujícího kola 
[11]  
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také méně energeticky náročná, i když spotřeba superpočítačů s velkým počtem procesorů je 
vysoká, přesto je množství energie potřebné na provoz tunelu daleko vyšší.  

Nejdříve musí být dostupný CAD model zkoumaného objektu. Ten vznikne navržením 
geometrie v některém z používaných  3D modelářů, nebo objekt naskenován 3D scannerem a 
dále doupraven. V této diplomové práci byl pro vytvoření modelu použit software 
Pro/ENGINEER Wildfire 5.0. 

Povrchová a objemová síť byla zpracována v produktu z balíčku ANSYSu 13, ICEMu 
CFD. Následně byla objemová mesh importována do sofistikovaného CFD řešitele, zde 
ANSYS FLUENT V6, kde byla provedena simulace proudění kolem karoserie vozu. Tento 
program má široké využití v mnoha odvětvích průmyslu. Obsahuje fyzikální modely 
postihující široké možnosti potřebné k modelování proudění, turbulence, přenosu tepla a 
reakcí pro průmyslové aplikace.  

Posledním z použitých programů je ANSYS CFD-Post, kde byla provedena 
vizualizace a porovnání naměřených dat. 
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3 TVORBA MODELU V  PRO/ENGINEERU 
 

3.1 MODELOVANÉ VOZIDLO  
Za modelované vozidlo jsem si zvolil formuli Ford 1600, jelikož Ústav automobilního a 

dopravního inženýrství na Vysokém učení technickém v Brně jeden exemplář tohoto vozidla 
vlastní. Jedná se závodní vozidlo z osmdesátých let s motorem z Fordu Escortu s obsahem 
1600 cm3. 

 

Jak již bylo v úvodu zmíněno, hlavním požadavkem bylo, aby bylo na modelu možné 
nastavovat výšku a úhel natočení mezi karoserií a vozovkou, nezávisle pro přední a zadní 
nápravu. Za tímto účelem byl zvolen program Pro/ENGINEER Wildfire 5.0, ve kterém je 
možné modelovat v 3D prostředí parametricky. Celá formule byla vymodelována jako 
přibližný model skutečného vozu. Přesné rozměry formule Ford 1600 byly dodány vedoucím 
diplomové práce Ing. Janem Vančurou, jelikož tento vůz také dříve modeloval. Celý model 
vozidla byl vytvořen pomocí standardních objemových operací. 

 

3.2 KAROSERIE 
Jako první byla navrhnuta karoserii formule. Jednalo se o hlavní a nejsložitější část 

CAD modelu.  Nejprve byl otevřen nový výkres typu Part. Dále byla zvolena rovina, ve které 
model vznikal, a to příkazem Sketch. Pomocí příkazu Extrude bylo vytvořeno vytažení 
poloviny půdorysu formule. Poté přišlo na řadu odečítání dalších objemových objektů od 
základního tělesa, aby bylo dosaženo co nejvěrnějšího tvaru karoserie. 

 

Obr. 13 Formule Ford 1600 se závodníkem Paulem Meijerem 
[14]  
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. 

 
Další kroky spočívaly v úpravách modelu pomocí zaoblování Round a zkosení hran 

Edge Chamfer. Na řadu přišlo vytvoření prvku uchycení zavěšení kol, opět bylo použito 
vytažení a zaoblení hran.  

Chránič hlavy byl vytvořen pomocí vytažení profilu po křivce a to příkazem Sweep > 
Protrusion. Konstruování tohoto prvku bylo provedeno pomocí vytvoření Sketche v pomocné 
rovině Plane.  

Vytvoření tvaru vstupu chlazení formule bylo provedeno opět kombinací vytažení, zkosení a 
zaoblení těles. Dalším prvkem byl vstup sání motoru za hlavou řidiče. Jednalo se o vytvoření 
plochy mezi dvěma uzavřenými křivkami, které se nacházejí v na sebe kolmých rovinách. 
Tato plocha byla vytažená po trajektorii, tvořenou prostorovou křivkou. Na tento konstrukční 
prvek bylo použito příkazu Sweep blend.  

Zrcátka byly vytvořeny vytažením uzavřené křivky narýsované v pomocné rovině a 
následným zaoblením. Spojení s karoserií bylo zajištěno pomocí příkazu Sweep > Protrusion.  

Po odzrcadlení příkazem Mirror  už začal model připomínat formuli. Následovala modelace 
zjednodušeného, oproti originálu více aerodynamického, výfuku a připojení rovněž 
zjednodušené převodovky. V tomto stavu byla součást uložena a na řadu přišlo vytvoření 
dalších částí.  

Obr. 14 Vytažený půdorys karoserie formule  
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3.3 KOLA 

Kola byla vymodelována také ve zjednodušeném a výpočtu postačujícím provedení. 
Vznikla poměrně jednoduše, a to vytažením kružnice. Na válci se následně zaoblily obvodové 
hrany a upravilo se místo styku kol s vozovkou, důvod úpravy bude vysvětlen v kapitole 4.4.  

 

 

 
 

Obr. 15 Ozrcadlená karoserie formule s dalšími konstrukčními 
prvky  

Obr. 16 Zjednodušené kolo s úpravou místa styku s vozovkou  
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3.4 HELMA 
Helma vznikla obdobně jako kola, tedy vytažením základního profilu tvaru elipsy a 

následným zaoblením hran. 

 
3.5 SKLÁDÁNÍ SESTAVY  

V tuto chvíli již byly všechny komponenty sestavy formule vytvořeny a uloženy jako 
soubory typu Part. Následovala kompletace sestavy.  

Do nového dokumentu typu Assembly byly postupně vloženy všechny části vozidla 
pomocí příkazu Assemble. Dále bylo velice důležité zamyslet se a vhodně zvolit způsob 
zavazbení jednotlivých prvků vůči sobě, aby byl dodržen hlavní požadavek. Aby bylo možné 
karoserii výškově nastavovat a natáčet ve směru osy x, musely být karoserie a kola na sobě 
zcela nezávislé. 

 

 

 
Proto byly tyto prvky zavazbeny vůči hlavním rovinám sestavy. Po vložení součásti nám 
vyskočí nabídka Placement, ve které nastavujeme umístění vložených Partů v prostoru 
pomocí vazeb. Tyto vazby byly vytvořeny mezi hlavními rovinami jednotlivých prvků a 
hlavními rovinami sestavy, viz obr. 17. V nabídce bylo použito příkazů Mate a Align, které 
nám určují vlastnosti nastavení jednotlivých typů vazeb. Pro přesné zadání vzdálenosti mezi 
rovinami bylo požito Offsetu, ve kterém se udala v milimetrech referenční vzdálenost mezi 
zavazbenými rovinami. 

Obr. 17 Nastavení vazeb mezi hlavními rovinami kol a sestavy 
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Dále bylo nutné vytvořit zavěšení mezi koly a karoserií. Na karoserii a kolech byly 
vytvořeny pomocné roviny, na které byly zadány pomocné body o souřadnicích 
odpovídajících umístění konců ramen zavěšení. Tyto body se propojily pomocnou osou. 
Příkazem Sweep > Surface byl vytažen kruhový profil po přímce, z bodu karoserie k bodu 
kola. Výhodou tohoto řešení je fakt, že při změně polohy karoserie vůči kolům se zavěšení 
přizpůsobí. Upraví svoji délku a sklon podle polohy referenčních bodů.  

 

Styk jednotlivých ramen zavěšení musel být upraven pro další použití převedeného 
CAD modelu v CFD prostředí. Jednotlivé části zavěšení se nemohly spojovat v jednom bodě 
přímo na povrchu kola či karoserie, a to kvůli správnému vytvoření prizmatických buněk, viz 
kap. 4.4. Proto se vytvořila pomocná rovina hlouběji uvnitř tělesa a jednotlivé prvky byly 
protaženy až na ni. Na povrchu kola a na karoserii byly již tyto části zavěšení v  postačujícím 
odstupu od sebe, viz obr. 19. Zmiňované protažení do nitra tělesa bylo v pozdější části práce 
s modelem (tvoření meshe) jednoduše odmazáno. 

 

Obr. 18 Vytváření zavěšení kol 

Obr. 19 Vytváření příznivé geometrie pro ulehčení tvoření meshe 
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Cílem diplomové práce je provést citlivostní studii vlivu polohy karoserie závodního 
vozu na jeho aerodynamické zatížení. Za tímto účelem vznikla čtyři různá nastavení modelu. 
Nastavovaným parametrem byla výška dna podvozku karoserie a vozovky a úhel natočení 
karoserie vozu vůči vozovce. Změna polohy karoserie byla možná díky vhodnému zavazbení 
jednotlivých komponentů. Rozdílná výška byla dosažena zadáním rozdílné hodnoty 
v nastavení vzdálenosti rovin dosednutí kola na vozovku a dna karoserie. Pro nastavení 
natočení byla vytvořena v rovině dna podvozku pomocná osa, podél které byla formule 
natočena. 

 

Obr. 20 Výsledný pohled na CAD model formule Ford 

Obr. 21 Ukázka nastavení podvozku na 70 mm 
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Tab. 1 jednotlivé úlohy k analýze 

Úloha 
Nastavení 

Vzdálenost karoserie od 
vozovky [mm] 

Natočení karoserie vůči 
vozovce [º] 

1. 40 0 

2. 70 0 

3. 90 2 

4. 120 0 

  
 

Dalším krokem byl import modelu z Pro/ENGINEERu do výpočtového prostředí 
CFD. Příkazem File > Save a copy byla sestava uložena do formátu STEP.  Při ukládání 
musela být nastavena položku Surfaces, což znamená, že uložený model je tvořen pouze 
plochami.  

Model byl též zjednodušen, aby se zabránilo příliš složitému výpočtu. Formule přišla o 
zrcátka a zavěšení kol bylo ochuzeno o některé komponenty.
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4 TVORBA SÍTĚ V ICEMU CFD 
Jak již bylo v kap. 2.2 vzpomenuto, CFD je zkratka anglického výrazu Computational  

Fluid Dynamics, což znamená počítačová dynamika tekutin. Jedná se o počítačovou simulaci 
proudění a přenosů tepla s využitím specializovaného softwaru, který umožňuje 
konstruktérům simulovat a analyzovat aerodynamické vlastnosti u zamýšlené konstrukce 
dříve než jsou vyrobeny. Hlavními výhodami tohoto postupu konstruování jsou významná 
redukce času potřebná pro výzkum a vývoj a nahrazení finančně náročnější simulace proudění 
kolem skutečného modelu v aerodynamickém tunelu. 

Dalším krokem v postupu k simulaci proudění kolem karoserie je vytvoření nejprve 
povrchové a následně objemové meshe a připravit ji na import do programu FLUENT V6. 
Pod pojmem mesh si můžeme představit síť uzlových bodů o určité struktuře uspořádání, 
na nichž program při simulaci sbírá a vyhodnocuje jednotlivá data. 

4.1 ÚPRAVA GEOMETRIE  
Celá formule byla po importování tvořena velkým množstvím různých ploch a křivek, 

v geometrii byly díry a nepřesnosti způsobené importem a nevhodným konstrukčním řešením 
návrhu modelu v Pro/ENGINEERu.  

Nejprve bylo zapotřebí geometrii zkontrolovat a pokusit se případné chyby v povrchu 
opravit. Kontrolu je provedena v záložce Geometry > Repair geometry > Build Topology, 
byla nastavena požadovaná tolerance a zapnuto pamatování vymazaných křivek pro možnost 
jejich probuzení v případě potřeby, Keep dormant as dormant.  

 

 

Opravená geometrie modelu by měla být tvořena pouze červenými povrchovými 
křivkami a to jen na místech výskytu náhlých geometrických přechodů. Důvodem je správný 
růst meshe. Červená barva nám říká, že jsou křivky tvořeny pouze spojením 2 ploch. Každá 
odlišná barva značí, že je geometrie modelu v nepořádku. 

Obr. 22 Formule a) před úpravou b) po úpravě geometrie 
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Zelená barva = křivka není připojena k žádnému povrchu. 

Žlutá barva = křivka náleží jen jednomu povrchu. 

Modrá barva = křivka je tvořena průnikem více než dvou povrchů. 

 

 

 

Body se na povrchu modelu neodstraňují jen na uzlu spojnic tří povrchových křivek. 
Vše ostatní musí být smazáno, jelikož se síť při svém růstu těmito elementy řídí, viz obr. 23. 
Když je geometrie opravená, sloučí se jednotlivé plochy na Party, což znamená na jednotlivé 
části modelu formule, aby na nich bylo možné nastavit rozdílné podmínky tvoření meshe, viz 
obr. 24. 

 

Obr. 23 Ponechané uzlové body 

Obr. 24 Rozčlenění formule na jednotlivé Party 



BRNO 2011 

 

32 
 

TVORBA SÍTĚ V ICEMU CFD 

Dále se kolem formule vytvořil tunel o rozměrech 43 x 9 x 4,5 m, aby vznikl prostor pro 
nastavení objemové meshe. Na tunelu zůstaly obrysové křivky a body na vrcholech kvádru. 
Tunel byl také rozčleněn na jednotlivé Party. Když byl model takto připravený, mohlo se 
přejít k nastavování meshe.  

 

 

4.2 POVRCHOVÁ MESH 
Nejdříve bylo potřeba zamyslet se nad velikostí elementů, aby bylo možné provést 

rozumně výpočet. Jelikož je model formule v měřítku 1:1, byla zvolena v nabídce Mesh > 
Global Mesh Parametres velikost největšího globálního elementu na 900 mm a nejmenší na 
10 mm. Další volbou byl typ elementů meshe Guard Dominant a meshovací metoda Patch 
Dependent.  

Důležité je i nastavení maximálních velikostí elementů pro jednotlivé Party. 
V nabídce Mesh > Part Meh Setup bylo možné příslušné velikosti elementů nastavit. Menší 
elementy měly součásti o malém povrchu, jako například zavěšení a chránič hlavy, naopak 
větší velikosti buněk měly rozlehlejší plochy, například kapotáž či kola, viz obr. 26. 

Po zadání všech parametrů byl spuštěn výpočet povrchové meshe v nabídce Mesh > 
Compute Mesh > Surface Mesh > Compute. 

 

 

Obr. 25 Rozčlenění tunelu na jednotlivé Party 
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4.3 OBJEMOVÁ MESH  
Zde se volí typ elementu meshe Tetra/Mixed, meshovací metodu Robust (Octree) 

počet Smoothovacích iterací, tzn. počet vyhlazovacích cyklů na minimální kvalitu sítě. Je 
zvoleno též uzavírání chyb a děr v meshi. Následovalo spuštění výpočtu. 

Obr. 26 Nastavení maximální a minimální velikosti pro jednotlivé Party 

Obr. 27 Povrchová mesh 
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4.4 VYTVOŘENÍ PRIZMAT 
Tvorba prizmat nám simuluje existenci mezní vrstvy (viz kap. 1.4), která obklopuje 

každý obtékaný předmět. V této vrstvě je rozdílný profil proudění oproti zbytku okolního 
prostředí, způsobeném nižší rychlostí proudění v bezprostředním okolí povrchu. Byl zadán 
počet vrstev a exponenciální způsob růstu následující vrstvy. 

 

 
Aby se v meshi vytvořilo co nejméně nekvalitních elementů, mělo by být na modelu 

minimum, nejlépe však žádné, přechody s ostrým úhlem. Tyto prostory se obtížně plní 
elementy. Proto byl styk kol s vozovkou nebo upevnění závěsu na kole upraveno tak, aby se 
tento nepříznivý vliv na mesh odstranil, viz obr. 4, obr. 19. 

 
4.5 NASTAVENÍ DENSITY  

Densitu můžeme chápat jako možnost místního nastavení rozdílných podmínek růstu 
elementů v povrchové a objemové meshi. Tuto možnost volíme v případě, že chceme 
přesnější výsledky v požadovaném místě. Zde byla tato možnost využita v okolí formule. 
Densita se zadá pomocí dvou bodů na přímce. Dále musí být zadána velikost density, počet 
vrstev a růst density. 

V závěru, když je vytvořená objemová mesh s prizmatickými vrstvami a densitou, se 
provede kontrola kvality meshe a případně se Smoothováním upraví na příslušnou minimální 
hodnotu tak, aby bylo elementů s nízkou kvalitou co nejméně, řádově v tisícinách procent. 
Hodnota konečného počtů elementů vytvořené objemové sítě se u všech čtyř modelů 
pohybovala okolo 2 600 000. 

 Posledním krokem v ICEMu CFD je export objemové meshe ve formátu pro 
FLUENT V6 . 

Obr. 28 Objemová mesh s prizmatickými vrstvami 
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Obr. 29 Ukázka objemové meshe s prizmatickými vrstvami a densitou, 
boční pohled  

Obr. 30 Ukázka objemové meshe s prizmatickými vrstvami a densitou, 
šikmý pohled 
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5 NASTAVENÍ PARAMETR Ů PROUDĚNÍ VE FLUENTU V6 
V tomto výpočtovém programu se provedlo nastavení parametrů a okrajových 

podmínek proudění. Model byl převeden na systém parciálních diferenciálních rovnic. 

 

5.1  ZADÁNÍ ZÁKLADNÍCH CHARAKTERISTIK  
Příkazem File > Read > Mesh byla importována síť. V nabídce Problem Setup > 

General > Scale bylo zkontrolováno a popřípadě upraveno měřítko. Poté následovala kontrola 
meshe, zadalo se tíhové zatížení v ose y. Dále byl pro výpočet zvolen materiál vzduch a 
model turbulence k-epsilon, který nám pro zvolený výpočet nejvíce vyhovuje a je 
nejpoužívanějším modelem.  

 

 

 

Tab. 2 Zadání hodnot pro základní fyzikální veličiny 

Fyzikální veličina Hodnota 

Tlak 101325 Pa 

Rychlost 27,78 m/s (100km/h) 

Teplota 20ºC 

Hustota 1,18415 kg/m3 

Obr. 31 Zadávání parametrů v programu FLUENT 
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5.2 ZADÁNÍ OKRAJOVÝCH PODMÍNEK  
V dalším kroku se nastavily parametry pro jednotlivé části modelu. Výchozí hodnota 

rychlosti formule v tunelu byla 100 km/h. Tato hodnota musela být promítnuta na všechny 
komponenty, které byly v pohybu.  

Pro prvky kapotáž, chránič, helma, vstupy, výstupy, kola, silnice a zavěšení byl zvolen 
typ prvku Wall (stěna).  

Pro tunel/inlet byl nastaven typ prvku velocity-inlet a nastavena rychlost proudícího 
média na 27,78 m/s (100 km/h). 

Pro tunel/outlet byl nastaven typ prvku pressure-outlet a tlak na vtupu p = 0 Pa 

Pro silnici byl nastaven typ prvku Wall a byla zadána rychlost translačního pohybu 
vozovky 27,78 m/s v kladném směru osy x. 

Pro kola, která byla taky typu Wall, se nastavil rotační způsob pohybu a musela se 
přepočtem určit úhlová rychlost při simulaci jízdy formule rychlostí 100 km/h.  

Pro každé kolo se zadala úhlová rychlost ω = 105.2273 rad/s. Také musely být zadány 
souřadnice os rotací pro jednotlivá kola, rotační pohyb probíhal kolem osy z. 

 

Do nabídky Problem Setup > Reference Values byla zadána automaticky spočtená 
čelní plocha formule a zadala se rychlost proudění. 

 

 

> = ��  (14)  

Obr. 32 Nastavení okrajových podmínek pro levé přední kolo 
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5.3 NASTAVENÍ MONITOROVÁNÍ ODPORŮ 
V nabídce Solution > Monitors byl nejprve přenastaven residuál na vlastnost, aby 

výpočet pokračoval až do konečného počtu nastavených iterací a neskončil při určité hodnotě 
přesnosti konvergence. Dále byly vybrány parametry, které byly stěžejní pro měření. Šlo o 
koeficient odporu vzduchu Drag a koeficient vztlakové síly Lift. Nastavilo se automatické 
ukládání do textového souboru, automatické vykreslování do grafu, měřeny byly všechny 
povrchy typu Wall, kromě silnice. 

V nabídce Solution > Solution Initialization byla nastavena rychlost média -27,78 m/s 
v kladném směru osy x a zadání se inicializovalo. Před spuštěním výpočtu bylo nastaveno 
automatické ukládání výsledků po pěti stech iteracích, celkový počet iterací byl 4000. 



BRNO 2011 

 

39 
 

VIZUALIZACE A ZHODNO CENÍ VÝSLEDKŮ V CFD-POST VIZUALIZACE A ZHODNO CENÍ VÝSLEDKŮ V CFD-POST 

6 VIZUALIZACE A ZHODNOCENÍ VÝSLEDK Ů V CFD-POST 
 

6.1 VYPOČTENÉ HODNOTY 
U sledovaných hodnot koeficientu aerodynamického vztlaku a aerodynamické 

odporové síly bylo posledních 200 iterací zprůměrováno a zapsáno do tabulky a vyneseno do 
grafů. Naměřené datové soubory se načetly do programu CFD-POST a pomocí barevných 
schémat byla provedena vizualizace průběhu tlakových polí na modelu, na vozovce a na 
dalších kritických místech modelu a byl též vykreslen průběh rychlosti tvar proudnic kolem 
karoserie. 

Tab.3 Přehled výsledných koeficientů 

Nastavení podvozku Koeficient 
aerodynamického 

vztlaku cL 

Koeficient 
aerodynamické 
odporové síly cD Výška [mm] 

Natočení 
[º] 

40 0 0,5542 0,1873 

70 0 0,5575 0,1717 

90 2 0,5504 0,0889 

120 0 0,5838 0.172 
 
 
 

 
 

Obr. 33 Rozložení tlaku na vozidle, perspektiva 
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Tab.4 Přehled výsledných silových účinků 

Nastavení podvozku Aerodynamická 
vztlaková síla  

Fx[N] 

Aerodynamická 
odporová síla  

Fz[N] Výška [mm] Natočení 
[º] 

40 0 -205,7 69,5 

70 0 -207,4 63,9 

90 2 -207,2 33,1 

120 0 -217,7 64,1 

 
 
 
 
 

Obr. 34 Hodnoty aerodynamických koeficientů 
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6.2 VIZUALIZACE VÝSLEDK Ů 

 

 

Obr. 35 Zobrazení rozložení tlaku na povrchu vozidla a na vozovce, 
nastavení výšky podvozku 40 mm, pohled shora 

Obr. 36 Zobrazení rozložení tlaku na povrchu vozidla a na vozovce, 
nastavení výšky podvozku 70 mm, pohled shora 
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Obr. 37 Zobrazení rozložení tlaku na povrchu vozidla a na vozovce, 
nastavení výšky podvozku 90 mm, natočení podvozku 2º, pohled shora 

Obr. 38 Zobrazení rozložení tlaku na povrchu vozidla a na vozovce, 
nastavení výšky podvozku 120 mm, pohled shora 
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Obr. 39 Zobrazení rozložení tlaku na povrchu vozidla a v rovině symetrie, 
nastavení výšky podvozku 40 mm, boční pohled 

Obr. 40 Zobrazení rozložení tlaku na povrchu vozidla a v rovině symetrie, 
nastavení výšky podvozku 70 mm, boční pohled 
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Obr. 41 Zobrazení rozložení tlaku na povrchu vozidla a v rovině symetrie, 
nastavení výšky podvozku 90 mm, natočení podvozku 2º, boční pohled 

Obr. 42 Zobrazení rozložení tlaku na povrchu vozidla a v rovině symetrie, 
nastavení výšky podvozku 120 mm, boční pohled 
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Obr. 43 Zobrazení rozložení tlaku na povrchu vozidla, nastavení výšky 
podvozku 40mm, pohled zepředu 

Obr. 44 Zobrazení rozložení tlaku na povrchu vozidla, nastavení výšky 
podvozku 70 mm, pohled zepředu 
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Obr. 45 Zobrazení rozložení tlaku na povrchu vozidla, nastavení výšky 
podvozku 90 mm, natočení podvozku 2º, pohled zepředu 

Obr. 46 Zobrazení rozložení tlaku na povrchu vozidla, nastavení výšky 
podvozku 120 mm, pohled zepředu 
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Obr. 47 Zobrazení rychlosti proudění kolem karoserie, nastavení výšky 
podvozku 40 mm, boční pohled 

Obr. 48 Zobrazení rychlosti proudění kolem karoserie, nastavení výšky 
podvozku 70 mm, boční pohled 
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Obr. 49 Zobrazení rychlosti proudění kolem karoserie, nastavení výšky 
podvozku 90 mm, natočení podvozku 2º, boční pohled 

Obr. 50 Zobrazení rychlosti proudění kolem karoserie, nastavení výšky 
podvozku 120 mm, boční pohled 
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Obr. 51 Zobrazení proudění kolem karoserie, nastavení výšky podvozku 
40 mm, perspektiva 

Obr. 52 Zobrazení proudění kolem karoserie, nastavení výšky podvozku 
70 mm, perspektiva 



BRNO 2011 

 

50 
 

VIZUALIZACE A ZHODNO CENÍ VÝSLEDKŮ V CFD-POST VIZUALIZACE A ZHODNO CENÍ VÝSLEDKŮ V CFD-POST 

 

 

 

Obr. 53 Zobrazení proudění kolem karoserie, nastavení výšky podvozku 
90 mm, natočení podvozku 2º, perspektiva 

Obr. 54 Zobrazení proudění kolem karoserie, nastavení výšky podvozku 
120 mm, perspektiva 
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Obr. 55 Zobrazení rychlostního pole v rovině symetrie s vznikem úplavu, 
nastavení výšky podvozku 40 m, boční pohled 

Obr. 56 Zobrazení rychlostního pole v rovině symetrie s vznikem úplavu, 
nastavení výšky podvozku 70 mm, boční pohled 
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Obr. 57 Zobrazení rychlostního pole v rovině symetrie s vznikem úplavu, 
nastavení výšky podvozku 90 mm, natočení podvozku 2º, boční pohled 

Obr. 58 Zobrazení rychlostního pole v rovině symetrie s vznikem úplavu, 
nastavení výšky podvozku 120 mm, boční pohled 
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6.3 ZHODNOCENÍ VÝSLEDKŮ 
Při porovnání naměřených a vypočtených hodnot pro jednotlivá nastavení podvozku 

formule byly ověřeny již známé fakta závislosti vztlakové a odporové síly na výšce vozidla 
nad vozovkou. 

 

Automobil se podobá leteckému křídlu. Spodní strana je rovný a horní strana zahnutý profil. 
Tudíž se jedná o profil nesouměrný. Rozdílná délka dráhy proudnic, které putují pod a nad 
autem nám způsobí, že tyto proudnice mají i rozdílnou rychlost. To nám zapříčiňuje efekt 
„k řídla“, který se vyskytuje u závodních aut bez přídavných aerodynamických prvků. Ve 
spodní části se nachází přetlak (vztlak) a v horní části podtlak. Výsledná vztlaková síla, která 
působí na formuli, směřuje od vozovky nahoru, což je nežádoucí jev. Proto se v motosportu 
používají přítlačná křídla, která na úkor vzrůstu aerodynamického odporu přemění vztlak na 
přítlak a tím radikálně zlepší jízdní vlastnosti vozidla.  

Z naměřených výsledků vidíme, že nejmenší vztlaková síla působí na model, který je nejblíže 
vozovce, pod kterým proudí nejméně vzduchu. Čím výše je podvozek nastaven, tím vztlak 
více roste. Na obrázcích 39-42 vidíme s postupným zvyšováním podvozku nárůst tlakového 
pole pod přední nápravou, dochází k jejímu nadlehčování. 

 U hodnot aerodynamické odporové síly nastává přesně opačná situace. Tato síla se 
vzrůstající výškou vozu klesá, jelikož stále větší množství vzduchu proniká pod modelem a 
nemusí proudit přes karoserii formule a přitláčet ji k silnici.  

Na obrázcích 43-46 vidíme místa, která jsou aerodynamickým odporem nejvíce postižena. 
Jedná se kola a přilbu řidiče. Vstupy sání, které zůstaly při nastavování podmínek zaslepeny, 
vykazují také velké tlakové zatížení. Velký aerodynamický odpor kol je částečně 
vykompenzován drobným přítlakem, způsobeným odtržením přilnutého proudění při rotaci 
kol. 

Obr. 55 Obtékání profilu tvaru křídla a) a automobilu b) [11] 
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ZÁVĚR 
 Úkolem této diplomové práce bylo sestrojit parametrický CAD model formule Ford 
1600 a následně zjistit aerodynamické charakteristiky pro různá nastavení výšky a natočení 
podvozku. Pro tento účel byl model importován do CFD prostředí, kde byly zadány 
charakteristiky prostředí a okrajové podmínky potřebné pro řešení.  

 Model byl pro tyto potřeby zjednodušen a byly vytvořeny čtyři různá nastavení polohy 
karoserie. Následně vznikly čtyři objemové sítě, které měly charakter výplně tunelu kolem 
modelu formule, na kterých byl proveden výpočet. Koeficienty, získané pomocí simulace, 
byly přepočteny na aerodynamické charakteristiky a pomocí barevných schémat byly 
demonstrovány výsledky. Byly ověřeny jízdní vlastnosti závodního vozu s nekrytými koly, 
které se s určitou chybou blíží skutečnosti. 

U konstruování CAD modelu bylo použito zbytečně mnoho detailních úprav, které později 
znesnadňovaly práci na geometrii v CFD softwaru, od některých částí karoserie bylo upuštěno 
a byly zjednodušeny. Jedná se však o plně parametrický model s možností dalších nastavení 
přední a zadní nápravy, nezávisle na sobě. 
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SEZNAM POUŽITÝCH ZKRATEK A SYMBOL Ů 

SEZNAM POUŽITÝCH ZKRATEK A SYMBOL Ů 

A [m2] čelní plocha vozu 

cx = cD [-] koeficient odporu 

cz = cL [-] koeficient vztlaku 

Fx [N] aerodynamický odpor 

Fz [N] aerodynamický vztlak 

p [Pa] tlak 

t [ºC] teplota 

V [m/s] rychlost 

V∞ [m/s] rychlost volného proudu 

δx [m] tloušťka mezní vrstvy 

θ [º] úhel odtržení přilnutého proudění od povrchu kola 

ρ [kg/m3] hustota 

υ [m2/s] kinematická viskozita 

ω [rad/s] úhlová rychlost kola 
 


